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This document shows you how to install and configure Model Manager PLUS.

Model Manager PLUS is a product from PTC’s Consulting organization that boosts your Model Manager product
installation with powerful add-on functionality and tools.
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Prerequisite : You must have a running installation of CoCreate Manager Server 2008 16.00 to install Model
Manager PLUS. This module is not compatible with older versions of OneSpace Manager or Work Manager!

1. To start the installation, run ModelManagerPlusSetup2008.exe on the server with the CoCreate Manager
Server 2008 16.00 installation.

I CoCreate Model and Drawing Manager PL sebup o o]

Welcome to the CoCreate Model
and Drawing Manager PLUS 2008
Setup Wizard

Thiz wizard will guide vou through the installation of
Zoireate Model and Drawing Manager PLUS 2005,

It is recommended that vwou close all other applications
before starting Setup, This will make it possible o update
relevant swskem files without having to reboat vour
compuker,

Click Mext ko continue,

Cancel |
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Choose the install location of CoCreate Manager Server 2008

% CoCreate Model and Drawing Manager PLUS 2008 Setup =101 =]

Choose Install Location

Choose the Folder in which to install CoCreate Model and Drawing Manager PLUS L_{"E:
2008, 573

Setup will install CoCreate Model and Drawing Manager PLUS 2008 in the Following Folder, To
install in a different Folder, click Browse and select another Folder, Click Install to skart the
installation.

i~ Destination Folder

”_:1Program Files\CoCreate)CoCreake Manager Server 20081

Browse, ., |

Space required: 1,3MB6
Space available; 5,5GE

Millsaft Install System w2 02

< Back I Inskall I Zancel

The Model Manager PLUS Setup dialog will appear.

Model Manager PLUS requires configuration information about your OneSpace Manager installation. If a
custom.xml file exists, most of this information will be read automatically and the message below will be
displayed:

x

@ Serverinformation read from “cuskom, xml”

If you do not have a custom.xml file, you’'ll need the following information to proceed:
Installation path and port of your database server.
Installation path and port of your fileserver.
Installation path of your license server.
Installation path Software Distribution server.
Installation path Notification Mail Server.
Installation path Notification Mail Server Email.
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This information will be necessary to create the startup files for Model Manager PLUS , Print Server, and
Output Server .

2. The Model Manager PLUS Setup dialog will appear:

£ Model Manager PLUS Setup ;|E|i|
[ General | Serverinfo | State(s)to Plot | State(s) to create PDF

Select Language english ll
Encoding US-ASCH -]

(0] 4 cancel

Select the language and encoding

During the installation process of Model Manager Plus the files mmplus.xml and ops.xml are

generated. You can choose the encoding of the generated XML files from a ComboBox during the installation
process.
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3. Enter server information

Model Manager PLUS Setup )

[ General [ Serverinfo | State(s)to Plot | State(s) to create PDF |

=101 %]

Server Installation

MS-Office integration

Licence Server

Database Server

Database Server port

File Server

File Server port

Software Distribution Server:port
Wehservices Server:port
Notification Mail Server
Notification Mail Server Email

v

OneSpace Designer Drafting installation directory{ ¢ ChiProgram Files\CoCreatelCoireats Drafting 2.., i

v

d10ws120

euosm-vmid01-tp

9593

euosm-vmid01-tp

9599

euosm-ymii01-tp: 80

euosm-ymio0]-tp: 3580

Check the Server Installation checkbox.
Select the directory of OSD Drafting
Check the MS- Office Integration checkbox

4, State(s) to Plot

& Model Manager PLUS Setup

rGeneraI r Serverinfo r"‘ 1t to Plot r"‘ 1t

State(s) to Plot
M

IV released

v approved
[~ archived
[ locked

to create PDF

ok, | cancel |

=10l x|

CK | cancel |

Check the State(s) to Plot checkboxes

D pr1C
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5. State(s) to create PDF

= Model Manager PLUS Setup

“General | Serverifo | State(s) o Plot | State(s) o create PDF |

r
r

Check the State(s) to create PDF checkboxes
Check all entries and click OK if correct.
6. Edit

C:\Program Files\CoCreate\CoCreate Model and Drawin g Manager 2008\config\plot\plot.ini

to define the printers used by the Plot Manager. See Section 4.2, Printer configuration for Plot Manager
for additional information.
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7. Create a new Model Manager installer (ModelManagerSetup.exe ) to integrate Model Manager PLUS by

running
C:\Program Files\CoCreate\ CoCreate Manager Server 2008\cIntwin\mmbuild.bat

in an MSDOS window. This will take several minutes. Once it finishes, the new ModelManagerSetup.exe
will be available on the Software Distribution Server.

8. Run ModelManagerSetup.exe by accessing the Software Distribution Server web page and selecting the
Install Model Manager link.

9. Create the classes necessary for Office Integration, the Output Server, and the Description Catalog by logging
in to Model Manager as a member of the group sysadmin as follows:

1. Start Model Manager

2. Enter the login and password of a member of the sysadmin group.

3. Select mmplus from the Select Configuration pick list. Click OK. The classes will be created as part of
startup. You may check for their successful creation by selecting File > New > Document , and expanding
the Class list. If MS_WORD is in the list, class creation was successful.

% _ PAGE ¢
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With Model Manager PLUS, you can manage Microsoft Word and Microsoft Excel documents in Model Manager.

The following chapters describe how to configure Model Manager PLUS to manage Microsoft Word documents.

The documents are managed in a separate Model Manager class. By default the following class will be installed:
MS_WORD Microsoft Word documents

In addition, the MS templates have a separate class:
MS_TEMPLATES Microsoft Templates

Business Object Class for the Office Integration:
com.mmplus.office.MmOffice

Within this Object class, different store options are defined, like “Create New Document,” “Create New Version,” and
“Overwrite.”

For load purposes, the following Action Menu Class is defined:
com.mmplus.office.actionmenu.OfficeActionMenu

Within this class, a specific load routine for Office documents is defined. The load routine examines all documents
and part attributes and transfers them to the Office application. Later, it checks if a file exists for this document.

Model Manager acts as a DDE Server and listens to the topic MMDdeServer and Modelmanager. The DDE Server is
started in the class MMDDEStarter. The registration of the loader class is done through the tag
<CommandLoaderClass>:

com.mmplus.dde. MMDDEStarter

To check in templates:
1. Create an empty document in the class MS_TEMPLATES.
2. When creating the document, the Application has to be specified:
WinWord Microsoft Word application
3. Check in the template file to the newly created document.

The Model Manager classes for the Office Integration are created the first time you start Model Manager PLUS after
installation. See Section 2 for further information.

The message file, mmoffice.msg, contains the display messages. These must reside in the lib/nls/msg directories.

#

The configuration of Office Integration is done within the XML file. The tags are defined within the
<Officelntegration> tag.
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<OfficelntegrationActive>
0 The Office integration is inactive.
1 The Office integration is active.

<WordClassName>
MS_WORD Model Manager class name for Word documents.

<TemplateClassName>
MS_TEMPLATES Model Manager class name for templates.

<WordExePath>
winword.exe

<SysldWord>

Winword DDE system identifier for Word.
<TemplateWinSizeX>
400 Size x in pixels for the Template window.

<TemplateWinSizeY>
300 Size y in pixels for the Template window.

<OfficeCommandWaitTime>

500 Time in ms before the command will be sent to the Office application.
<OfficeStartWaitTime>

2000 Time in ms before starting Office application
$ ! %

Word must access Visual Basic for Applications code to interface with Model Manager PLUS. Therefore, macro
security must be set to medium in Microsoft Word so the macros in the templates can run. Follow these steps to set
macro security:

1. Open Microsoft Word.

2. Select Tools > Options > Security tab > Macro Security men  u.

3. On the Security dialog, go to the Security Level tab and change the Security level from High to Medium .
Now each time you open a document in Model Manager PLUS you get the message Disable Macros or
Enable Macros . Choose Enable Macros to get the Microsoft Application to work with Model Manager
PLUS.

% pTC _ PAGE 11
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"C:\Program FilesiMicrasoft OFficeyOFFICEL LS TARTUPYmmplus. dot" contains
Securiby Lewvel | Trusted Publishers I macros.

™ Wery High. Only macros installed in trusted locations will be allowead
to rum. All other signed and unsigned macros are disabled.

Macros may contain viruses, It is usually safe to disable macros, but if the
™ High. Only signed macros fram krusted sources will be allowed ko macros are legitimate, you might lose some functionality.

run. Unsigned macros are automatically disabled.

i Medium, You can choose whether or nok ko run potentially unsafe isable Macros Enable Macros More Info
Mackos., E

™ Low {nok recammended). You are nok protected Fram patentially
unsafe macros. Use this setking only if wou have virus scanning
software installed, or wou have checked the safety of all documents
oIl Open.

(0] I Cancel

&I

The following chapters describe how to configure Model Manager PLUS to manage Microsoft Excel documents.

The documents are managed in a separate Model Manager class. By default the following class will be installed:
MS_EXCEL Microsoft Excel documents

In addition, the MS templates have a separate class:
MS_TEMPLATES Microsoft Templates

Business Object Class for the Office Integration:
com.mmplus.office.MmOffice

Within this Object class, different store options are defined, like “Create New Document,” “Create New Version,” and
“Overwrite.”

For load purposes, the following Action Menu Class is defined:
com.mmplus.office.actionmenu.OfficeActionMenu

Within this class, a specific load routine for Office documents is defined. The load routine examines all documents
and part attributes and transfers them to the Office application. Later, it checks if a file exists for this document.

Model Manager acts as a DDE Server and listens to the topic MMDdeServer and Modelman. The DDE Server is

started in the class MMDDEStarter. The registration of the loader class is done through the tag
<CommandLoaderClass>:

% p_[_C \ PAGE 12
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com.mmplus.dde. MMDDEStarter

To check in templates:
1. Create an empty document in the class MS_TEMPLATES.
2. When creating the document, the Application has to be specified:
Excel Microsoft Excel application
3. Check in the template file to the newly created document.

The Model Manager classes for the Office Integration are created the first time you start Model Manager PLUS after
installation. See Section 2 for further information.

The message file, mmoffice.msg, contains the display messages. These must reside in the lib/nls/msg/french
directories.

#

The configuration of Office Integration is done within the XML file. The tags are defined within the
<Officelntegration> tag.

<OfficelntegrationActive>
0 The Office integration is inactive.
1 The Office integration is active.

<ExcelClassName>
MS_EXCEL Model Manager class name for Excel documents.

<TemplateClassName>
MS_TEMPLATES Model Manager class name for templates.

<ExcelExePath>
excel.exe

<SysldExcel>

Excel DDE system identifier for Excel.
<TemplateWinSizeX>
400 Size x in pixels for the Template window.

<TemplateWinSizeY>
300 Size y in pixels for the Template window.

<OfficeCommandWaitTime>

500 Time in ms before the command will be sent to the Office application.
<OfficeStartWaitTime>
2000 Time in ms before starting Office application

%\‘_9 _ PAGE 13
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$ ! %

Excel must access Visual Basic for Applications code to interface with Model Manager PLUS. Therefore, macro

security must be set to medium in Microsoft Excel so the macros in the templates can run. Follow these steps to set
macro security:

1. Open Microsoft Excel.

2. Select Tools > Options > Security tab > Macro Security men  u.

3. On the Security dialog, go to the Security Level tab and change the Security level from High to Medium .
Now each time you open a document in Model Manager PLUS you get the message Disable Macros or

Enable Macros . Choose Enable Macros to get the Microsoft Application to work with Model Manager
PLUS.

PAGE 14
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# !

Plot Manager enables you to send drawings directly from Model Manager to the configured printers.

Plot Manager is configured in the following Model Manager PLUS files:
Plot Manager is defined in mmplus.xml .
Printers are defined in plot.ini.
Variables for the frames are defined for the right database schema language in globals.m

# () !
The configuration of the Plot Manager is done within the XML file (ops.xml in the directory
...\PrintServer\config_ops\config ).

The tags are defined within the < PlotManager> tag.

<PlotManager>
<PlotManagerActive> true </PlotManagerActive>
<ClassName> com.mmplus.spooler.PlotDialog </ClassName>
<GroupName>PLOTGROU&GroupName>
<MonitorGroup> MONITORGROWRVonitorGroup>
<PrintServerDirectory> PATH/PrintServerDirectory>
<DraftingDirectory> PATH</DraftingDirectory>
<ViewOption> -view </ViewOption>
<PlotIniFileUserLocation> PATH</PlotIniFileUserLocation>
<StateToPlot> STATES</StateToPlot>
<SearchLevel> LEVEL</SearchLevel>

</PlotManager>

Configuration is defined within the <PlotManager> tag as follows:

<PlotManagerActive> VALUE </PlotManagerActive>
Defines whether Plot Manager shall be used or not.

Optional:
True Plot Manager is active.
False Plot Manager is inactive.
Empty Plot Manager is inactive.

<ClassName> Java class </ClassName>
Required: Defines the Java class used for the Plot Manager.
com.mmplus.spooler.PlotDialog Fully qualified path to the Java class.

If the class does not exist, the menu item Send to plotter will not appear

<GroupName> GROUPNAME</GroupName>
Optional: Defines the Model Manager group that can use the Plot Manager

PLOTGROUP Plot Manager is only available to defined group.
Empty Plot Manager available to all users

In the database, any group may be defined to enable users to use the Plot Manager.
If this tag does not exist, Plot Manager will be available to all users.

<Monitor Group> GROUPNAME </Monitor Group>

PAGE 15
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Optional: Defines the Model Manager group that can use the Plot Manager Monitor

GROUPNAME Plot Manager Monitor is only available to defined group.
Empty Plot Manager Monitor available to all users

In the database, any group may be defined to enable users to use the Plot Manager Monitor.
If this tag does not exist, Plot Manager Monitor will be available to all users.

<PrintServerDirectory> PrintServer </PrintServerDirectory>
Required: Defines the relative path where PrintServer is installed.

PATH Path to install directory of PrintServer

<DraftingDirectory> PATH</DraftingDirectory>
Required: Defines the path where OSD- Drafting is installed.

PATH Path to install directory of OSD- Drafting .

<ViewOption>-view</ViewOption>
Defines the command-line parameter passed to Designer Drafting when passed.
-view 2D Access will run instead of Drafting.
Empty Drafting will run. Note. This setting is required to output file types other than pdf.

See the section File Export Configuration  for more information on generation of other file types.

<PlotIniFileUserLocation> PATH</PlotiniFileUserLocation>
Optional: Defines the location of the local plot.ini file.

Path to local plot.ini Points Plot Manager to this local plot.ini file.
Empty ModelManager client uses the plot.ini file in the /config  directory.

<StateToPlot> STATE</StateToPlot>
Optional: Defines which drawings states are allowed to plot.
There may be multiple tags with this name.

Work, approved, released List of states of which drawings can be plotted.
Empty Drawings in any state can be plotted.

<SearchLevel> VALUE </SearchLevel>
Optional: Defines the search level for drawings in structures.

0 Whole assembly structures.
1 One level of assembly structures.
Value Any integer to define the query level.
#
The name of the configuration file is plot.ini and localized in the following directory:
C:\Program Files\CoCreate\CoCreate Model and Drawin g Manager 2008\config\plot

Printers and plotters for the Plot Manager are defined here. You do not have to configure all available formats.

PAGE 16
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&
Define the printer as follows.

[PRINTER]
Computer= localhost
The variable “Computer” names the computer on which the PrintServer is installed.
e.g,. Computer=PrintServer
If the printer at the print server is installed as a
local printer, this entry remains empty
e.g., Computer=

ShareName=HPG85XX
Name of the printer. It must available in the network.
e.g., ljdmv_a

Alias= HP Office Jet G85 in design department
Name displayed in the selection list in Model Manager / Drawing Manager.
e.g., LaserJet 4MV Accounting

Format= A3, A2, Al
List of the formats printed by the printer. This list can be different from the formats actually supported by the
printer. The formats are comma-delimited. e.g., A4, A3
The format may be mapped within ME10/Drafting to the formats corresponding to the printer's paper selection.
This mapping is done by the macro Sco_set_print_paper_size . To use the correct format for each printer, this
macro has to be adjusted accordingly. To do so, it's important to correctly spell the sheet formats each printer
uses. For a DesignJet, an entry A4 for the format is not sufficient. The entire string in the macro which is also
offered during manual paper selection needs to be checked.
e.g., ISO A4 -210x 297 mm.
(The trailing period has to be entered as well!)

FormatAlias= A3-sheet,A2-sheet,Al-sheet
The name displayed in the selection list in Model Manager / Drawing Manager

Output= PCL, HPGL, TIFF, JPG, JPEG
The listing of output formats supported by the printer
Note. The variable Output is currently not supported.

MaxOutputSize= 0 0 180 250
Dimension for the output size. Like in the file plotdefs

* % & &
In this section global parameters are defined:

[PARAMETERS]

Reloadlni=1
1 Reload of “plot.ini” at each call of the plot menu is forced.
0 File “plot.ini” not reloaded

FitToPaper=1
The variable “FitToPaper” is related to the section [SCALE]. Scales output to fit paper size

PAGE 17
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1 “FitToPaper” is active for the drawing and defining a scale is not possible
0 Defining a scale is now active

DialogReduction= 100
To define how much smaller (in pixels) the dialog window is compared to the monitor width.

UserCanSeeAllJobs= 1

0 User can only see their own jobs in the Plot Manager monitor
1 User can see their own and all pending plot jobs in the Model Manager PLUS Plot Manager Monitor.
*&

In this section all user-allowed scaling can be defined:

[SCALE]
Scalelnit=1:1,1:2,1:5,1:10,1:2.5,1:100,10:1,2.5:1,5:1
A choice is only possible if fit to paper is inactive.

In this section the macro names are described that can be used for the drawing output.

To use this option the macros must input in OneSpace Manager Drafting. These macros are defined to get the right
drawing output. For example:
[COLOROPTION]
PLOTMACRO=True color,Sco_true_color
PLOTMACRO=Pen width,Sco_pen_width
PLOTMACRO=BIlack and white,Sco_black_and_white
Pen size Macro name, must before input in Drafting
Pen size defined by color Show text in Plot Manager

*&
In the section the possible rotation angles for print output are defined.
[ROTATE]

ANGLES=0,90,180,270
The Variable “ANGLES” contains a comma separated list.

# + | " ,
The configuration file globals.m , resides in the following directory:

C:\Program Files\CoCreate\CoCreate Model and Drawin g Manager 2008\PrintServer
The following (global) variables must be defined in this file:

Switch to reload TB (Title block)
0 DEFINE Awmc_val_tb_reload TRUE END_DEFINE

TB (Title block) — class name e.g. “FRAME_2D"
0 LET Awmc_val_tb_class 'FRAME_2D'
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Format, offset and version attribute nhame
o DEFINE Awm_db_format "FORMAT" END_DEFINE
o DEFINE Awm_db_offset “OFFSET” END_DEFINE
o0 DEFINE Awm_db_version “VERSION” END_DEFINE

Count of change notes to be displayed on the drawing
o DEFINE Awmc_val_max_change_notes 3 END_DEFINE

”

TB (Title block) prefix name e.g. “.tb_frame_’
o DEFINE Awmc_val_tbname_prefix ".tb_frame_" END_DEFINE

PAGE 19
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With the Model Manager PLUS Description Catalog or Thesaurus you can assign naming inside the OSDM and pass
the values to Model Manager during the save process.

The input dialog for the Description Catalog inside OneSpace Designer Modeling can offer multi-language fields. It is
possible to import these values from an external table.

$ ()

The Description Catalog is defined within the tag <DescCatalog>:

<DescCatalog>
<DescCatalogActive>true</DescCatalogActive>
<ClassName>BENENNUNGEN</ClassName>
<IndexAttr>BEZ_ID</IndexAttr>
<Attributes>BEZ_ID</Attributes>
<Attributes>BESCHREIBUNG</Attributes>
<Attributes>BESCHREIBUNG1</Attributes>
<Attributes>BESCHREIBUNG2</Attributes>
<Attributes>SPRACHE</Attributes>
<DbLength>10</DbLength>
<DbLength>250</DbLength>
<DbLength>250</DbLength>
<DbLength>250</DbLength>
<DbLength>25</DbLength>
<DbDescription>ID</DbDescription>
<DbDescription>Description</DbDescription>
<DbDescription>Description1</DbDescription>
<DbDescription>Description2</DbDescription>
<DbDescription>Language</DbDescription>
<MapAttributes>BEZ_ID</MapAttributes>
<MapAttributes>BESCHREIBUNG</MapAttributes>
<MapAttributes>SBESCHREIBUNG1</MapAttributes >
<MapAttributes>SBESCHREIBUNG2</MapAttributes >
<MapAttributes>SPRACHE</MapAttributes>
<DisplayNameBezld>ID</DisplayNameBezld>
<DisplayNames>Deutsch</DisplayNames>
<DisplayNames>English</DisplayNames>
<DisplayNames>Francaise</DisplayNames>
<DisplayNames>Sprache</DisplayNames>
<ColumnNames>GERMAN</ColumnNames>
<ColumnNames>ENGLISH</ColumnNames>
<ColumnNames>FRENCH</ColumnNames>
<ColumnNames>LANGUAGE</ColumnNames>
<ShouldOverwrite>true</ShouldOverwrite>

</DescCatalog>

Tags work as follows:

< DescCatalogActive>VALUE</DescCatalogActive>
Optional: Controls whether the catalog is used or not.

True Description catalog is active.
False Description catalog is inactive.
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Empty Description Catalog is inactive.

<ClassName>DESCRIPTION</ClassName>
Required: Defines the name of the database class that contains the naming.

DESCRIPTION Database- class for description catalog.

<IndexAttr>BEZ_ID</IndexAttr>
Required: Unique identifier of the description.

<Attributes>
Required: Defines the attributes of the description class.

BEZ_ID, DESCRIPTION,DESCRIPTION1,DESCRIPTION2,LANGUAGE List of the attributes.

<MapAittributes>
Optional: Defines the attribute of the target class 3d model. They are mapped 1:1 from the description class.
BEZ_ID, DESCRIPTION,DESCRIPTION,DESCRIPTION,LANGUAGE List of the attributes.
<DbLength>

Required: Length of attributes (used when class is created).

10,250,250,250,25 Length of the attributes.
<DbDescription>

Required: Describes the labeling of the attributes in the database.

ID, Description,Description1,Description2,Language Attribute labels in a comma-separated list

You can name the description catalog class free. The attribute names can also be chosen class free.

Note
It is important always to use correct mapping: <Attributes> and <MapAttributes>

If an existing database class is used for the Description Catalog, you have to configure it in the XML file.
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<Class>

<Name> BENENNUNGEMName>

<BusinessObjectClass> com.osm.biz.WMDoc </BusinessObjectClass>
<CanCreatelnUI> true </CanCreatelnUI>

<AuditTrail> OFK/AuditTrail>

<EditorClass> com.osm.datamgmt.editor.BaseEditor </EditorClass>
<NameFormat >%BESCHREIBUNG%:[%SPRACHEIlameFormat>
<Attribute> BENENNUNGAttribute>

<Attribute> BENENNUNGIAttribute>

<Attribute> BENENNUNG2Attribute>

<Attribute> SPRACHE/Attribute>

<Attribute>BEZ_ID
<Required>true</Required>
</Attribute>

</Class>

Note

The variable “language” is currently not supported.

$

Besides the XML configuration, additional configuration needs to be done inside OneSpace Designer Modeling to
activate this feature.

Basically you need to ensure that the files located in the directory
...ICoCreate/ CoCreate Model and Drawing Manager 2008 \OSDM\modelmanager

are loaded.

The file sco_mm_load.Isp

There are two ways to configure this:

1If you have defined a SDCORPCUSTOMIZEDIR environment variable, you need to

Copy the whole modelmanager subdirectory from

in this directory contains the load statements for all other files that need to be loaded.

..\CoCreate\CoCreate Model and Drawing Manager 2008\ OSDM\modelmanager

into your corpcustomize directory

Add a load statement for the sco_mm_load.Isp file in, e.g., your mm_customize file

e.g,

(load (format nil "~a/modelmanager/sco_mm_load" (o li::sd-sys-getenv
"SDCORPCUSTOMIZEDIR")))

2. If you don’'t have the SDCORPCUSTOMIZE variable defined, you need to

Add a load statement for the sco_mm_load.Isp file in, e.g., your mm_customize file

below)
Change the load statements in the sco_mm_load.Isp file.

Here's an example:

(see the example
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Add the following load statement into the mm_customize file

(setf *mm-custom-path* "C:\Program Files\CoCreate\C oCreate Model and Drawing Manager
2008\0OSDM\modelmanager")

(load (format nil "~a/sco_mm_load_new" *mm-custom-p ath*))

Replace the existing load statements in the sco_mm_load.Isp file using the following code.

(sd-with-current-working-directory *mm-custom-path*
(load "sco_mm_variables")
(load "sco_mm_customize")
(load "sco_mm_desc_lexikon")
(load "sco_mm_dialog")
(load "sco_mm_browser")

)
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The Output Server (OPS) lets you generate several file types when triggered by state changes in Model Manager. It
runs as a separate Model Manager client.

There are two modes to start the OPS.

Loop mode: This mode is started by running runop.bat . In this mode the server queries the Output Server table
and automatically processes jobs found in the table. The Model Manager workspace is not available, only a Model
Manager-like command window will appear. The OPS will also stop automatically.

Debug mode: This mode is started by running runop_debug.bat . In this mode the server displays a Model
Manager workspace and an OPS dialog to manage jobs manually.

When this class is created, the user opsmgr is created and added to the group sysadmin .

- () "

XML configuration for the OPS is performed in the file
...\CoCreate\CoCreate\CoCreate Manager Server 2008\co nfig\ops.xml

on the machine where the OPS is running.

The tags that affect the Model Manager Plus client like <StateToWork> and <OutPutServerTableName> also need to
be configured on the clients in the file mmplus.xml .

The Output Server is defined by the tag <OutPutServer>.

Possible tags inside the section <OutPutServer> follow:

<OutPutServer>
<Active> true </Active>
<OutPutServerTableName> OPS_TABLEX/OutPutServerTableName>
<StateToWork> released </StateToWork>
<OutPutServerShutDownAt>  time <OutPutServerShutDownAt>
<OutPutServerShutDownAllowed> true </OutPutServerShutDownAllowed>
<OutPutServerWaitTime> 10</OutPutServerWaitTime>
<OutPutServerLog> false </OutPutServerLog>
<OPSDisplayFormat> dd.MM.yyyy </OPSDisplayFormat>
<OPSK:illDraftingTime> 300 </OPSKillDraftingTime>
<OPSKillDraftingMacro> Macro name </OPSKillDraftingMacro>
<OPSStoreFileTypes> file types </OPSStoreFileTypes>
<OPSStoreDwgVersion> ACAD Version </OPSStoreDwgVersion>
<OPSStoreDirectory>  PATH</OPSStoreDirectory>
<CreateMultibXF> true </CreateMultiDXF>
<CreateMultibWG> true </CreateMultiDWG>
<CreateMultibDWF> true </CreateMultiDWF>
<CreateMultiPDF> true </CreateMultiPDF>
<CreateMultiiGES> true </CreateMultiiGES>
<CreateMultiSVG> true </CreateMultiSVG>

</OutPutServer>
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Tags work as follows:
<Active> VALUE </Active>
Required: Defines whether the OPS is used or not.

True OPS is used.
False OPS is not used.
Empty OPS is not used.

<OutPutServerTableName> TABLENAME </OutPutServerTableName>
Required: Defines the OSM class for the OPS. OPS jobs are written to this table.

OPS_TABLE1 DB-Class name for the Output server.

<StateToWork> released </StateToWork>
Required: Defines the state that, when transitioned to, will cause the OPS to generate a PDF. If the state
subsequently changes from this state, the generated PDF document will automatically be deleted.

There may be multiple tags with this name.

<OutPutServerShutDownAt> time string <OutPutServerShutDownAt>
Time string Time string to shut down OPS, e.g., “22:30”

<OutPutServerShutDownAllowed> true </OutPutServerShutDownAllowed>
True OPS will shutdown if shutdown time has arrived.

<OutPutServerWaitTime> 10</OutPutServerWaitTime>
Integer Seconds to wait before executing next job query.

<OPSDisplayFormat> dd.MM.yyyy </OPSDisplayFormat>
Time format Time format to be used for drafting (TB references) time strings, e.g., CREATED_AT

<OPSKillDraftingTime> 300</OPSKillDraftingTime>
Integer Seconds to wait before Drafting will be killed.

<OPSKillDraftingMacro> Macro name</OPSK:illDraftingMacro>
Macro name  Macro that should be used to kill Drafting.

<OPSStoreFileTypes> file types </OPSStoreFileTypes>
CSL File types to be stored during release process.

<OPSStoreDwgVersion> ACAD Version </OPSStoreDwgVersion>
Macro option  Macro option to store DWG files.

<OPSStoreDirectory> PATH</OPSStoreDirectory>
Path Path to export files to the file system

<CreateMulti???> true </CreateMulti???>
True Every sheet will be stored in a separate file.

Replace the ??? with one of the following file types:

DXF
DWG
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DWF
VRML
SVG
IGES

+ m

The Output Server can create and store different file formats and check the files into the database.

Note

To enable generation of the following file types, the <ViewOption> tag in the <PlotManager> section of the ops.xml
file must be set to empty. See section 5.1 XML-Plot Management configuration  for more.

Do the following to configure this option:

Modify the tag <OPSStoreFileTypes> file types </OPSStoreFileTypes> Enter any of the following file types
(comma-separated) Drafting is able to create.

(0]

O O0OO0Oo0oo

DXF
DWG
DWF
VRML
SVG
IGES

If you want to create DWG files (AutoCAD file type) you also have to define the desired AutoCAD version.
Enter the store version in the tag <OPSStoreDwgVersion> ACAD Version </OPSStoreDwgVersion> . For
more information about the possible AutoCAD versions see the OneSpace Designer Drafting documentation.

For each file type you can define a different store location. The store root directory is defined in the tag
<OPSStoreDirectory> PATH</OPSStoreDirectory>

Directory names for export additional formats (DXF, DWG...)

(0]

O O0OO0OO0OO0OOo

DEFINE Sco_ops_dxf_extern_dir "dxf_export" END_DEFINE
DEFINE Sco_ops_pdf_extern_dir "pdf_export" END_DEFINE
DEFINE Sco_ops_vrml_extern_dir "vrml_export" END_DEFINE
DEFINE Sco_ops_dwf_extern_dir "dwf_export" END_DEFINE
DEFINE Sco_ops_svg_extern_dir "svg_export" END_DEFINE
DEFINE Sco_ops_iges_extern_dir "iges_export" END_DEFINE
DEFINE Sco_ops_dwg_extern_dir "dwg_export" END_DEFINE

The created files can be imported into the database.

Switch to check in the created formats

(0]

DEFINE Sco_ops_checkin_neutral_formats TRUE END_DEFINE
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